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Foreword 
The corporate world is going through constant changes in technology and information. The teamwork 
concept is crucially relevant for companies’ performance and success.  

The corporate environment is more and more complex and competitive, leading companies to make 
continuous use of people’s creativity and potential, in addition to developing, updating and perpetuating 
working tools that will keep achievements under control in an organized and safe way, providing 
managers with a broad managerial view.  

The project managerial concepts, broadly propagated by the Project Management Institute (PMI) in all of 
its stages (Start, Planning, Accomplishment, Control and Finish), are aligned in a simple objective easy-
to-understand systematic way in this book, turning it into a planning and control handbook.  

The author has pursued, with a high analytical skill, supported by the MS-Project powerful management 
tool, to open all the stages of a project, showing since the creation of the activity list, efficiently using the 
resources, updating and control, to the completion of several projects. 

The book is a great benefit for professionals and companies using the project management. 

 

Danilo de Oliveira Nascimento  - Project Manager  
 
 

Introduction 
This book has been developed aiming to present the main resources on Microsoft Project 2003, leading them to be used 
by engineers and technicians involved in planning and control works.  

At Part I – Project Management General Concepts, comprising Chapters 1 to 3, some of the main concepts related to 
Project Management are succinctly presented, as well as the definition of planning and control terms and tools used 
along this book.  

At Part II – Presenting Microsoft Project 2003, comprising Chapters 4 to 8, the main features of Microsoft Project 
2003 are presented, including its characteristics and specifications, installation requirements, views and tabs as well as 
instructions on how to use the application help.  
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At Part III – Developing ABC Project, comprising Chapters 9 to 21, a complete planning and control example named 
ABC Project is developed, since the activity list creation to the resource usage and report issue. That example, presented 
in an organized way, directed to the book scope, purports to be a guide for the development of other projects’ planning 
and control.  

At the Appendix, the whole ABC Project is presented, including cost composition, budgetary spreadsheet, Project 
Analytical Structure (PAS), a pool of material and human resources and the ABC Project Schedule.  

The CD-Roms included in the book presents a full version of Microsoft Project 2003, valid for use for 120 (one hundred 
and twenty) days, in addition to the ABC Project files.  

The Author is at his readers’ service and thanks in advance for any comments and suggestions that they may wish to 
make by e-mail: contato@planejamentodeobras.com.br.  

A positive contribution to every professional using this book is expected. 

 

Rosaldo J. E. Nocêra - June /2006 
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2.4.4 - SHEETS, MAPS AND FORMS 

When managing projects, we usually have sheets, maps and forms as important tools that may be 
developed in software applications like Microsoft Excel®. 

Therefore, we may have among other ones: 
z sheets with the quantities of services and hours; 
z unit cost sheets; 
z labor histograms; 
z work physical follow-up maps. 

When designing the ABC Project, which is part of the Appendix, several examples of sheets, maps 
and forms are presented.  

 
 2.4.5  - “S” CURVE 

As time goes by, the companies engaged in project management have observed the evolution of 
service performance was not taking place in a linear manner, rather according to a Gauss Curve. 
Hence, that evolution presented the following stages: 

Slow Start – as it is in a project recognition stage and its needs, by executors, as well as by the few 
related resources and the low synergy among the engaged personnel. 

Fast Growth Stage – due to the nearly total knowledge of the project stages and needs, by largely 
employing the resources and the high synergy among the engaged personnel. 

Slow Finish Stage – due to the use of few resources (many of which are already demobilized), the 
absence or non-compliance of closing checklists, and the natural mutual wear among the engaged 
personnel. Graphically, in a coordinate system, evolution is presented in the form of a long “S”, as 
shown by figure 2.8. 
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Fig 2.8 – “S” curve 

 
In projects involving Engineering, Supplies, Construction and Assembly, each of these activities 
presents a different “S” curve, however they must be analyzed together so that an activity is not 
delayed or jeopardize the following one. 

Figure 2.9 shows an example of ideal curves for a project of this kind.  
 

n Ideal curve for engineering and design – Percentage of total man-hours; 
   o Ideal curve for material and equipment purchase – Percentage of purchase service total man-
hours; 

p Ideal curve for construction – Percentage of man-hours.  
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Fig. 2.9 – “S” Curves for engineering, supplies and construction 

 
Obviously, the best thing to be done is that each company carries out time and method surveys and 
assembles their own “S” curves. Nevertheless, in practicality it becomes extremely difficult and 
burdensome, due to the project diversity, amount of similar tasks that would need to be studied, as 
well as the several alternatives for resource utilization (for example, mechanical or manual digging) 
in order to carry out each task. Therefore, companies usually choose to use “S” curves found in 
specific bibliographies, and correct the expected advances while services are performed. On the 
following page, there is an example of “S” curve used for construction and assembly works, for up 
to 24 periods of time (days, weeks, months, etc). 
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Fig. 2.10 – Physical advance distribution for construction and assembly projects 

 
For the estimate on the activity progress, follow the example below:  

Work period – 6 months 

Physical Progress in each period (see line 6 – 1st frame in each column): 

  3.5% - 9.6% - 23.0% - 33.3% - 21.5% - 9.1%  

Accrued Physical Progress (see line 6 – 2nd frame of each column): 

  3.5% - 13.1% - 36.1% - 69.4% - 90.9% - 100%  

For an activity, we would have the following schedule:  

 
2.4.6 - PROJECT GENERAL BOOK 
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The Project General book is a group of documents that must present the project main data, the final 
product aspects and all the facts happened during its lifetime. 
Among other topics, it may contain the following: the project scope, the objectives, the budget 
data, the profit forecast, the agreement’s requirements, the final and partial deadlines, the expected 
resources, the managing team expected, the project analytical structure, possible problems, 
deviations occurred during the performance, not expected additional resources, etc.  
The Project General Book represents not only a reference source about the project life, but also a 
relevant reference for other projects. 
 

(1) – It is also known as WBS - Work Breakdown Structure. 
 
11.3.2  - USING THE TASK FORM 

- Select the Window menu, Split to view the Task Form at the bottom half screen; 
- At the Gantt Chart select the task for  which you wish to establish a predecessor; 
- Click anywhere in the Task Form to select it; 
- Click on the first line of the Predecessor Name column on the right tab; 
- Roll down the arrow and select the predecessor; 
- At the Type column, select the type of link; 
- At the Lag column, type the positive number to insert a lag or a negative number to demand a 

lead. 

Figure 11.4 shows the Task Form. In order to remove or hind the Task Form, select the Window 
menu, Remove Split. 

 

 
Fig. 11.4 - Using the Task Form 
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 11.3.3 -  USING THE ENTRY TABLE 
- Move the Gantt Chart vertical split bar to the right, until you view the Predecessors column, 

as shown by figure 11.5. 
 

 
Fig. 11.5 - The Predecessors column at Gantt Chart 

 
- At the Predecessors column, select the task line for which you wish to establish a predecessor; 
- To insert a Finish-to-Start link, type the predecessor ID number; 
- To insert other types of link, type the predecessor ID number followed by the initials of the 

desired link (SS, FF, SF); 
- To insert lag times, after the ID number and the link initials, type the plus sign and the number 

of lag days; 
- To insert the lead times, after the ID number and the link initials, type the minus sign and the 

number of lead days. 
 
 
14.1 - INTRODUCTION 

In this chapter, we will work managing resource management, involving the creating of a resource list, 
resource assignment to tasks and cost assignment to task resources. 

 
14.2 - DEFINING RESOURCES 

The resources in your project can be considered as people, equipment, materials or any help to benefit the 
performance of task in the project. 

Example: 

Person Resources: Architect 
 Foreman 
 Bricklayer 
 Carpenter 
 Assistant Bricklayer 
 Etc. 

Material Resources: Cement 
 Sand 
 Stones 
 Tiles 
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 Etc. 

Equipment Resources:   Cement mixer 
 Handcart 
 Truck 
 Crane 
 Etc. 

Other Types: Meeting Room 
 Material Warehouse 
 Overhead Projector 
 Microcomputer 
 Etc. 

 
14.3 - DEFINING COSTS 

You may not use costs related to resources and directly to tasks, forming the task total cost. If the 
resource-related cost is not necessary, only the task fixed cost can be used. 

 
 14.3.1  - RESOURCE COST 

The resource costs may be calculated the time spent on performing the task or even the quantity 
of resources assigned to it. According to type cost we define to the resource, it has a different 
behavior. 

As MS-Project calculates the cost of a task according to a resource earning per worked hour, we 
have: 

  
 Resource  Worked Total 
 Default Rate Hours Calculated Cost 

 
 R$ 5,00/h 10 h R$ 50,00 
    R$ 100,00/d   10 h* R$ 125,00 

*  MS-Project converts the resource default rate (100) dividing it by the daily hours (100 divided by 8) to result in the cost per hour 
(R$ 12,50/h). Therefore, this value is multiplied by the quantity of worked hours. 

 
 14.3.2  - TASK COST 

In addition to the cost calculated by the resource worked hours, we can insert a cost regardless 
the resource, that is, a fixed cost to the task. 

When you define a resource or insert a cost to the task, you must also specify when the 
associated cost will be recognized in a financial report.  When the project is updated, MS-
Project calculates the cost based on the method chosen for each resource or fixed cost. 

 
14.4 -  CREATING A RESOURCE LIST 
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Before assigning resources to the tasks, it is important that a study is carried out for each task to be 
performed and that the necessary resources are defined for its total completion. Usually, this study can be 
made based on the Services Cost Compositions like in the ABC Project. In practicality, we will show how 
to create a resource list out of the active project (Kit of resources), enabling to use these same resources in 
other projects. 

On the View menu, select the Resource Sheets options. 

This way, we have this view fields split into columns, for the data entry: 
 

 

Fig. 14.1 - Resource Sheet columns 
 

Indicator Indicates the resource status (status is automatically defined); 

Resource Name Identifies the resource name; 

Type Defines the resource type – work or material; 

Material Label Specifies the material measure unit; 

Initials This field can be used to inform the resource name initials (instead of its full 
name); 

Group It is used to identify a group of resources. For example, Assistant Bricklayer 
and Bricklayer are part of the LA (labor) Group; 

Maximum Units You define the maximum number of available resources for the association in a 
project. It can be comprised as a percentage or decimal digit. Select Tools menu 
/ Options / Schedule guide, click on Show assignment units as: Decimal or 
Percentage; 

Standart Rate It is used for the time unit cost for the resource work. You can use it followed 
by the time unit m (cost per minute), h (cost per hour), d (cost per day), or y 
(cost per year); 

Overtime Rate When work is defined as overtime, the rate cost can be formed in this field; 

Cost / Use A cost is added once each resource unit is associated to the task; 

Accrue The method used by MS-Project to calculate the performed task cost. 

Start – The resource total cost in the task will be formed in the start of its 
performance; 

Prorated – The resource total cost in the task will be formed while it’s 
performed; 

Finish – The resource total cost in the task will be formed at the end of its 
performance. 

Base Calendar                Identifies the resource calendar. The resource may use hours differentiated by 
another calendar; 
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Code You can insert any type or resource ID (for example: an Employee’s Registry 
Number). 

 
By analyzing the services cost compositions at the Appendix, a list of resources was created that can be 
used as an example. 

The Cost Compositions values used in the example are in reais (R$) and they are the same as MS-Project 
values in US$. Thus, it is understand that 1R$ is equal to 1US$. 

At the ABC Project: 
Each cost composition sheet constraint (created using MS-Excel) corresponds to the tasks in the MS-
Project project and each task in this sheet shows the composition of Materials, Equipment and Labor, thus 
comprising the Total Composition Cost related to the project in question. There is also the Unit Cost per 
task, so that you can have it as a reference. The elements of this composition will take part in our list of 
resources. 

Every type of material resource inserted in the list of materials, as for example, Cement, you will find in 
the Cost Composition sheet, as shown by figure 14.2. 

 

 
Fig. 14.2 - Cost composition 

 
We added the cement unit cost in Cost / Use of the Resource sheets, because for each kilogram of cement 
in the task the cost of R$ 0,12 will be counted, as shown by figure 14.3. 

 

 
 

Fig. 14.3 - Resource sheet 

 

16.1 -  INTRODUCTION 
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In this chapter, more information about the available view modes at MS-Project is presented as well as 
the creation of new view modes and tables, the use of filters, aiming customizing the documentation 
according to the project need. 

 
16.2 -  VIEW MODE TYPES 

The view modes can be grouped in two categories: view modes for tasks and resources.. 

These modes can be presented in the format of sheets, diagrams, graphs and forms. 

To visualize the view modes, access the View menu. The most used are listed in that menu, while the full 
list appears when selecting the More views option. 

 
 16.2.1  - TASK VIEW MODES 

The task view modes are used when you wish to insert, change or view information on a task. 
The following table shows the task view modes on MS-Project. 

 

Task view modes Description 
 A list of summary tasks containing labels of all subtasks. Use this view mode with 

the Acummulate_formatting macro to see all the tasks labeled in a summarized way 
in the summary task bars. . 

Calendar A monthly calendar for tasks and durations. Use this view mode to show the tasks 
scheduled in a weekly specific time range. 

Detail Gantt A list of related tasks and information and a graph showing the lag slacks and the 
lead time. Use this view mode to check how long a task can be postponed without 
affecting other tasks. 

Gantt Chart A list of related tasks and information and a graph showing the tasks and durations 
along the period. Use this view mode to insert and schedule tasks. 

Leveling Gantt A list of related tasks and information and a bar graph showing the leveling previous 
and later effects. Use this view mode to check how much a task is delayed. 

Accumulation of stage dates A list of summary tasks containing the labels for all subtasks. Use this view mode 
with Acumulate_formatting macro to see all tasks labeled in a summarized way with 
marks and stage dates on the summary task bars. 

Stage accumulation A list of summary tasks containing the labels for all subtasks. Use this view mode 
with the Acummulate_formatting macro to see all the tasks labeled in a summarized 
way with stage marks on the summary task bars. 

Network Diagram A network diagram showing all the tasks and dependencies among tasks. Use this 
view mode to create and adjust your schedule using a flowchart format. 

Relationship Diagram A network diagram showing the Predecessor e successor task of another task. In a 
large project use this view mode to highlight the dependencies of a specific task. For 
such, open the Relationship Diagram view mode on the bottom panel in a combined 
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way with another task view mode, such as Gantt Chart or Task Sheet on the top 
panel. 

Task Details Form A form used to assess and edit detailed information on tracking and scheduling 
about a specific task. 

Task Entry  A combined way with the Gantt Chart view mode on the top panel and with the 
Task form view mode on the bottom panel. Use this view mode to add, edit and 
assess detailed information about the selected task in the Gantt Chart view mode. 

Task Form A form used to enter and edit information about a specific task. 

Task Name Form A form used to enter and edit the task name and other information about it. 

Task sheet  A list of related tasks and information. Use this view mode to enter and schedule 
tasks in a electronic sheet format. 

Task Usage A list of tasks showing the assigned resources grouped under each task. Use this 
view mode to see which resources are assigned to specific tasks and how many 
hours the resources worked on a task. 

Tracking Gantt  A list of related tasks and information and a board showing Baseline Gantt bars and 
scheduled for each task. Use this view mode to compare the baseline to the real 
schedule (you will need to save a baseline to view the baseline bars). 

Descriptive Network Diagram  A Network Diagram showing all the tasks and dependencies among them, the 
resources for each task and if it is critical or not. 

Multiple Baselines Gantt A Gantt Chart showing the several baselines of a project. 
 

16.5.3  - CREATING OR CHANGING A FILTER 
If any of the filters provided with MS-Project meets your needs, you may create a new filter, 
create a filter based on another one or edit an already existing one.  

When creating a new filter, you start with a blank filter to which you add each field and specify 
details, such as field width and field title. 

When creating a filter based on another existing one, you will change a copy of that filter 
without changing the original. 

When editing an existing filter, you will change its original. 

To create or change a filter, take the following steps: 

1. On the Project menu, select Filter for and click on More filters;  

2. To create or change a task filter, click on Task and then click on a filter from the Filters list. 
To create or change a resource filter, click on Resources and then click on a filter from the 
Filters list; 

3. To create a new filter, click on New. 
To create a filter based on another existing one, click on that filter from the Filters list and 
then click on Copy. 
To edit an existing filter, click on that filter from the Filters list and then click on Edit; 
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4. In the Name box, type a new name for the filter; 

5. In Filter select a field name and a test; 

6. In the Value (s) field, click on a value to be tested or click on a value range separated by a 
comma (,). 

 For example, if you have clicked on is within or is not within in the Test field, type “From”?, 
“To”? to create an interactive filter that requires a date range to be tested; 

7. If the filter contains more than a criterion line, select additional conditions in the line 
immediately below the first one and click on a field operator in the And/Or field in the same 
line. Maybe it is necessary to use the right arrow key to view this field; 

8. Click on OK; 

9. To apply the filter immediately, click on Apply. 

 

20.1 -  INTRODUCTION 

As important as designing a consistent planning is the progress tracking. By tracking you can: 

l Keep the project updated with the performance actual data; 

l Compare actual data with the baseline data, aiming at  dealing with problems, as well viewing possible 
problems in advance and taking corrective actions; 

l Design status reports to the management and project participants; 

l To make and keep a historical database to help future budgeting and planning. 

To be efficient, it is necessary to perform tracking in a consistent and regular way. The optimum thing to 
do is setting a performance interval – weekly, fortnightly, monthly, and strictly follow it. What is 
important is not exceeding the time limits to correct deviations and anticipate new problems. 

Therefore, maybe the tracking interval for those supervising the final services is one week for the service 
performers and two weeks or one month for the person responsible for the project costs. 

For a detailed tracking, the following variables must be controlled: 
l Task start dates; 
l Task finish dates; 
l Percent complete for each task; 
l Task duration; 
l Task cost; 
l Work. 

 
20.2 -  INSERTING ACTUAL START AND FINISH DATES IN A TASK 

Task actual start and finish dates may have a significant impact on the project, as lag time start and finish 
tasks may delay other ones, and tasks with a lead time may enable anticipating other tasks or releasing 
resources to other tasks. 

To insert actual start and finish dates for a task, take the following steps: 
1. On the View menu, click on Gantt Chart; 
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2. In the Task Name field, select the task you wish to update; 

3. On the Tools menu, select Tracking and click on Update tasks; 

4. In Actual, type the dates in the Start and Finish boxes. 
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